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Read Me First!  Information about your new 68 channel/32 pixel sequence 

 You bought a sequence. Now what? 

 If the sequence includes the music 

 Purchase the music before installing the sequence 

 What if you can’t purchase the music at Amazon.com 

 Downloading your sequence(s) 

 Copy your sequences to a safe place because your computer will die 

 What are you getting? 

 Make sure the ShowTime Sequencing Suite is installed and what level you’ll need 

 I’m using the Demo version of the ShowTime Sequencing Suite 

 Directories (folders), where we’re putting stuff and secret codes 

 No ShowTime Sequencing Suite but still want the sequence 

 Sequence cannot find the audio file? 

 ‘Can’t init conversion’ 

 The music is not the right volume compared to other tunes 

 Sequences and shows 

 Changing your sequences 

 Converting a ‘Ready To Go’ to a ‘You Can Modify’ sequence 

 Channel layout suggestions for this 68 channel, 32 pixel sequence 

 Typical layouts 

 Can I use this new sequence with sequences I bought long ago? 

 Using your purchased sequence with ShowTime Director 

 Please don’t share 

 Commercial use 

 Need more help? 

 Final suggestion 

 One last piece of advice. 

You bought a sequence. Now what? 

After the successful purchase of a Light-O-Rama sequence, you will receive a confirmation email with a serial number 

and link to immediately download it. The download link is at the bottom of the email. If you're still in the sequencing 

store, look under 'My Accounts', 'Track your recent orders' and click 'View Details' to find the download link. 
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If the sequence includes the music 

Some of our sequences include music, meaning Light-O-Rama has taken care of the licensing requirements for you. The 

music file is included with your sequence to make things easy. Please keep in mind we have arranged for the music to be 

licensed only to you so copying the music file to share with others is not allowed. Skip the next couple of topics about 

buying the music. 

Purchase the music before installing the sequence. 

In the sequence store description, we provide a link to where to purchase the music at www.Amazon.com. Purchase and 

download the music to your computer before installing the sequence. 

What if you can’t purchase the music at www.Amazon.com? 

Locate and purchase the music in your country. Make sure the music track length is the same as what’s specified in the 

sequence store. Purchase and download the music to your computer before installing your sequence. 

Downloading your sequence(s) from the Light-O-Rama sequence store 

Each Light-O-Rama sequence store order typically involves two or more files to download to your computer. The first file 

is named something like C1234-RTG.exe or C1234-YCM.exe. This is the actual sequence information. Some Internet 

browsers will warn this file might not be safe. We scan the files daily for viruses so they should be safe.  

The last file to download is called ReadMeFirst-C68P32.pdf and includes the contents of what you are reading now. 

Copy your sequences to a safe place because your computer WILL die 

Make a copy of the sequence installation file(s) and the store receipt (including the unique sequence serial number). Put 

this information in a safe place for future reference. Best practice is to keep this information on a different storage 

device than your current computer. If the computer stops functioning for any reason, your purchased sequence can be 

installed on another computer. 

This sequence is licensed to you and is for your use only. This license cannot be transferred. Please do not share this 

sequence with others. A unique serial number is embedded in the sequence and can be traced back to the original 

purchase. 

Bottom line: make a backup copy of your sequences and store it somewhere else other than the computer you’re 
working on. 

Make sure the Light-O-Rama ShowTime Sequencing Suite is installed 

You must have a recent version of the Light-O-Rama ShowTime Sequencing Suite software already installed on your 

computer. If you do not have this software, please go to www.LightORama.com to purchase the product. 

Your sequence was written with the latest version of the ShowTime Sequencing Suite software. It will usually work with 

earlier versions of our software but we always recommend being on the latest-and-greatest so the best tools are 

available.  

‘Ready To Go’ sequences can only be guaranteed to work with ShowTime Sequencing Suite version 3.8 and higher. 

http://www.amazon.com/
http://www.amazon.com/
http://www.lightorama.com/
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What level of ShowTime Sequencing Suite do you need? 

This sequence uses 68 regular channels and 32 RGB based pixels. Start with just one controller (controller Unit ID 01 

and/or Unit ID 07) and add more controllers later. 

The number of controllers used in the sequence is based on the Light-O-Rama Sequencing Suite software package 

license level installed on your computer. Open the Light-O-Rama Sequence Editor and look at the window title bar to see 

what license level you have. Depending on the license level, here are the controller Unit IDs available for your use: 

 Demo: no controller Unit IDs are used 

 Basic: controller ID's 01 and 02 

 Basic Plus: controller IDs 01, 02, 03 and 04 

 Standard: controller IDs 01, 02, 03, 04, 05, 06, 07 and 08 

 Advanced: controller IDs: all 

 Pro: controller IDs: all 

Light-O-Rama sequencing software 3.8.2 or later is required to use all the features of this sequence. 

If your current level of the Light-O-Rama Sequencing Suite does not include all the controllers you want to use, consider 

an upgrade. Find out more at http://www.lightorama.com 

I'm using the Demo version of the ShowTime Sequencing Suite 

If your installed Light-O-Rama ShowTime Sequencing Suite says 'Demo' in the top title bar of the window, it does not 

send any control signals to any controllers. This is a free version of the software and meant for testing and 

demonstrations only. Make sure your software says 'Basic', 'Basic Plus', 'Standard', 'Advanced' or ‘Pro’ in the top title 

bar.  

How to install the sequence 

Before the sequence is installed, make sure the Light-O-Rama Sequence Suite is already working fine on your computer. 

Once the sequence installation file is downloaded, you will then need to run it to install the sequence information on 

your computer. Locate and double click the downloaded sequence installation filename to start the installation. Read 

the prompts very carefully and allow the downloaded file to run. 

What are you getting? 

Upon the receipt of a Light-O-Rama sequence, you will be receiving one installation file that includes the follow files 

embedded within: 

 A Light-O-Rama sequence file (it ends with .lms)  
 The Light-O-Rama sequence installer  
 If music is included, then an audio file (it ends with .mp3)  

The sequence installer will put the sequence in your default Light-O-Rama sequence directory. 
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If your Light-O-Rama sequence includes music, then we will put the music file in your default Light-O-Rama audio 
directory. The music file will typically have the same name as the sequence but end with .mp3. You can skip to the next 
topic. 

If your Light-O-Rama sequence does not include the music we provide a link to purchase the music through 
Amazon.com. The music is licensed directly to you. Amazon embeds a unique identifier in the music file that can be 
tracked back to the original purchase.  

It’s important to use the same musical track we specify. Since there can be different versions of the same song by the 
same artist, the light patterns can be off if a music version is different than what the sequencer used. 

The sequence installer will search the computer for the correct music file needed by the sequence, create a copy, put it 
into your default Light-O-Rama audio directory and attempt to link the sequence to the music. 

Sequence information is placed in the appropriate Light-O-Rama directories created when the Light-O-Rama Sequencing 

Suite software package was installed. Remember: sequences cannot be installed without this package in place.  

Directories (folders), where we’re putting the stuff and secret codes 

Typical default paths for Light-O-Rama directories referenced in this document:  

 Sequences:  Local Disk (C:) > Users > name > Documents > Light-O-Rama > Sequences   (Your default path might 

be different.) 

 Audio/Music:  Local Disk (C:) > Users > name > Documents > Light-O-Rama > Audio   (Your default path might be 

different.) 

 Instructions: Local Disk (C:) > Users > name > Documents > Light-O-Rama > Sequences   (Your default path might 

be different.) 

The -C68P32 in the sequence name means the sequence uses 68 channels and 32 pixels. 

The -RFM in the sequence name means royalty free music is used and is included with the sequence. No extra music 

licensing is necessary. 

The -YCM in the sequence name means it is a 'You Can Modify' sequence. You have the full source code and can change 

any part of the sequence including reassigning Unit IDs and adding more controllers (if your license level allows it.) 

The -RTG in the sequence name means it is a 'Ready To Go' sequence but cannot be modified in any way. The sequence 

is encrypted with no access to any effects or controller/channel assignments. 

If the sequence did not include the music, in most cases we found the licensed music file already on your computer, 

copied it to the default Light-O-Rama Audio directory, renamed the music file slightly to match the sequence name, 

added -SN at the end of the filename and linked the music to your new sequence.  

If the sequence includes the music, we placed the music file in the default Light-O-Rama Audio directory. It's the same 

name as the sequence, has -SN at the end of the filename, is saved in the .mp3 format and linked to your new sequence.  

The -SN in the music file name means we converted it to a standard CBR, 128kbps, .mp3 format and attempted to 

normalize the volume.  
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No ShowTime Sequencing Suite but still want the sequence? 

Store the installation file in a safe place. Once you have the ShowTime Sequencing Suite installed, licensed and running 

on your computer, then install the sequence as explained earlier. 

Sequence cannot find the audio file?  

Should you open your new sequence in the ShowTime Sequencing Suite Sequence Editor and get a message saying it 

cannot find the audio file or cannot get the last modification time, go to Edit -> Media File, browse to the 

appropriate music file (typically in your default Light-O-Rama Audio directory) and select it. Save your sequence and all 

should be AOK. 

‘Can’t init conversion’ 

This is programmer speak for ‘your music file is something I don’t understand’ and can happen if you’re running a 

version 3.9 or earlier of Light-O-Rama software. You can usually fix things by going to this website: http://audio.online-

convert.com/convert-to-mp3. Upload your music, it will convert it to a standard format (CBR, 128kbps, .mp3) and 

download the converted music back to your computer.  

You might need to go through the ‘Sequence cannot find the audio file?’ section above to link the converted music back 

to your sequence.  

The music is not the right volume compared to other tunes 

The recording artist has full creative control of what you hear. Unfortunately, some like it soft and others like it VERY 

loud. There's a technique known as 'normalization' that attempts to make the audio you hear more consistent. This is 

typically a one-time process that will adjust the music levels as needed in the computer file.  

We've had good success using a free program called Audacity (http://www.audacityteam.org). It's a bit geeky, but very 

powerful. Download and install Audacity on your computer. We recommend using the standard .mp3 file format so be 

sure to also download the 'LAME MP3 encoder' from Audacity (http://www.audacityteam.org/download/windows/) and 

Audacity will read/write .mp3 files. Start Audacity, open the audio file used by the sequence, go to Effects->Normalize, 

use the default value and watch the magic. One special note:  Save or export the Audacity normalized audio file back to 

your default Light-O-Rama Audio directory. Best practice is to rename the new file and leave the original file alone. Make 

sure this new file is linked to the sequence (open the sequence in Sequence Editor and goto Edit->Media File) and you're 

good to go. Still perplexed by all this?  Ask a teenager for help. 

Another normalization option is to use an on-line service. Upload the music file. Let the service work the magic and 

download the normalized file. A good example is http://audio.online-convert.com/convert-to-mp3. Browse to your 

music file typically in the default Light-O-Rama Audio directory, select it, leave the 'optional settings' alone, check the 

'Normalize audio' option and click 'Convert file'. Wait for your file to upload and convert then watch for the dialog box to 

downloaded the 'normalized' audio. Save the normalized audio file back to your default Light-O-Rama Audio directory. 

Best practice is to rename the new file and leave the original file alone. Make sure this new file is linked to the sequence 

(open the sequence in Sequence Editor and go to Edit -> Media File) and you're good to go. 

There are other normalization options available. Do an Internet search on 'music normalization'   

 

http://audio.online-convert.com/convert-to-mp3
http://audio.online-convert.com/convert-to-mp3


ReadMeFirst-C68P32.pdf              Light-O-Rama, Inc.     22 Hudson Falls Road, South Glen Falls, NY  12803      www.lightorama.com                   page 6 

Sequences and shows 

This sequence and your legally licensed music will play fine on your computer through the ShowTime Sequencing Suite 

Sequence Editor. To run the sequence in other modes, it needs to be converted to a show. See your ShowTime 

Sequencing Suite on-line help for more information.  

Changing your sequences  

If your sequence is designated 'You Can Modify' (look for -YCM in the sequence name) then you can change the light 

patterns as well as add/edit/delete controllers and light channels as you see fit through the ShowTime Sequencing Suite 

Sequence Editor. You can use your sequence as a starting point to build something awesome! 

Special note: if you change the sequence, save it as a different name. If you make a mistake you can return to the 

original sequence and start again. 

Open the -YCM sequence using the ShowTime Sequencing Suite Sequence Editor. You’ll see something like this screen 

on your computer: 

 

Not much to look at but look carefully at those little ‘+’ signs next to each Unit ID description. Click the ‘+’ to expand the 

channels associated with that Unit ID. 
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Now you can change the effects as desired.  Collapse the channels by pressing the ‘-‘ sign. 

Your sequence only uses one track but there could be several different timing grids depending on how the sequence 

artist interpreted the music. Look in the upper right corner for a timings dropdown arrow and click to see any other grids 

that might be used.  

If your sequence is designated 'Ready To Go' (look for -RTG in the sequence name) then opening the sequence within 

the Sequence Editor will allow you to view only the channel layout and change the audio file linked to the sequence.  

You will not see a grid like above.  

Converting a ‘Ready To Go’ Sequence to a ‘You Can Modify’ sequence 

There is no capability to upgrade a ‘Ready To Go’ sequence to a fully editable ‘You Can Modify’ sequence. You will need 

to purchase the sequence from the Light-O-Rama store as a ‘You Can Modify’ sequence. 

Channel layout suggestions for this 68 channel, 32 pixel sequence  

This sequence takes advantage of multiple Light-O-Rama controllers. Controller ID 01 and ID 02 use four groups of four 

light circuits. Controller ID 03 and ID 04 use two groups of eight light circuits. See below for other controllers. We break 

things up into colors or segment numbers just to make it a little easier to understand but you can connect your lights as 

you see fit. 

Standard 16 channel controllers (see the Typical Layout drawing later for this to make more sense): 
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channel 
Controller 

ID 01 
Controller 

ID 02 
Controller 

ID 03 
Controller 

ID 04 
Controller 

ID 05 
Controller  

ID 06 

1 Group A - section 1 Fixture E - 1  (red) Arch I - segment 1 Tree K - segment 1 Not used Strobes 

2 Group A - section 2 Fixture F - 1  (red) Arch I - segment 2 Tree K - segment 2 Not used Strobes 

3 Group A - section 3 Fixture G - 1  (red) Arch I - segment 3 Tree K - segment 3 Not used Strobes 

4 Group A - section 4 Fixture H - 1  (red) Arch I - segment 4 Tree K - segment 4 Not used Strobes 

5 Group B - section 1 Fixture E - 2  (green) Arch I - segment 5 Tree K - segment 5 Not used Not used 

6 Group B - section 2 Fixture F - 2  (green) Arch I - segment 6 Tree K - segment 6 Not used Not used 

7 Group B - section 3 Fixture G - 2  (green) Arch I - segment 7 Tree K - segment 7 Not used Not used 

8 Group B - section 4 Fixture H - 2  (green) Arch I - segment 8 Tree K - segment 8 Not used Not used 

9 Group C - section 1 Fixture E - 3  (blue) Arch J - segment 1 Tree L - segment 1 Not used Not used 

10 Group C - section 2 Fixture F - 3  (blue) Arch J - segment 2 Tree L - segment 2 Not used Not used 

11 Group C - section 3 Fixture G - 3  (blue) Arch J - segment 3 Tree L - segment 3 Not used Not used 

12 Group C - section 4 Fixture H - 3  (blue) Arch J - segment 4 Tree L - segment 4 Not used Not used 

13 Group D - section 1 Fixture E - 4  (yellow) Arch J - segment 5 Tree L - segment 5 Not used Not used 

14 Group D - section 2 Fixture F - 4  (yellow) Arch J - segment 6 Tree L - segment 6 Not used Not used 

15 Group D - section 3 Fixture G - 4  (yellow) Arch J - segment 7 Tree L - segment 7 Not used Not used 

16 Group D - section 4 Fixture H - 4  (yellow) Arch J - segment 8 Tree L - segment 8 Not used Not used 

 

Standard RGB based Pixel Controllers such as the CMB24D (see the Typical Layout drawing later for this to make more 

sense) 

RGB 
Port 

Controller 
ID 07  

CMB24D 
RGB Channels 

  

1 Dumb pixel P1   1, 2, 3 Group 1 Duplicated at controller ID 20 on channels 1, 2, 3 

2 Dumb pixel P2   4, 5, 6 Group 1 Duplicated at controller ID 21 on channels 1, 2, 3 

3 Dumb pixel P3   7, 8, 9 Group 1 Duplicated at controller ID 22 on channels 1, 2, 3 

4 Dumb pixel P4   10, 11, 12 Group 1 Duplicated at controller ID 23 on channels 1, 2, 3 

5 Dumb pixel P5   13, 14, 15 Group 1 Duplicated at controller ID 24 on channels 1, 2, 3 

6 Dumb pixel P6   16, 17, 18 Group 1 Duplicated at controller ID 25 on channels 1, 2, 3 

7 Dumb pixel P7   19, 20, 21 Group 1 Duplicated at controller ID 26 on channels 1, 2, 3 

8 Dumb pixel P8   22, 23, 24 Group 1 Duplicated at controller ID 27 on channels 1, 2, 3 

 

RGB 
Port 

Controller 
ID 08  

CMB24D 
RGB Channels 

  

1 Dumb pixel P9   1, 2, 3 Group 2 Duplicated at controller ID 28 on channels 1, 2, 3 

2 Dumb pixel P10   4, 5, 6 Group 2 Duplicated at controller ID 29 on channels 1, 2, 3 

3 Dumb pixel P11   7, 8, 9 Group 2 Duplicated at controller ID 2A on channels 1, 2, 3 

4 Dumb pixel P12   10, 11, 12 Group 2 Duplicated at controller ID 2B on channels 1, 2, 3 

5 Dumb pixel P13   13, 14, 15 Group 2 Duplicated at controller ID 2C on channels 1, 2, 3 

6 Dumb pixel P14   16, 17, 18 Group 2 Duplicated at controller ID 2D on channels 1, 2, 3 

7 Dumb pixel P15   19, 20, 21 Group 2 Duplicated at controller ID 2E on channels 1, 2, 3 

8 Dumb pixel P16   22, 23, 24 Group 2 Duplicated at controller ID 2F on channels 1, 2, 3 
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Each CMB24D dumb pixel port (P1 through P16) is also duplicated at an individual controller ID (20-2F). Use these 

individual controller IDs with single pixel high power floods that have a built-in controller or with smart pixel controllers 

that have been configured so each port is just one pixel (meaning each smart pixel port acts as a dumb pixel port). 

Does the above make your head hurt?  On the following pages are more detailed explanations and pictures of a typical 

layout. 
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Typical layout for a venue 

 

This can be quite intimidating if you’re new to animated shows. See the previous page for a larger version of the above 

drawing. It shows how 68 channels and 32 pixels can be deployed on a building. 

The key to success is thinking in small groups. Light patterns typically work best in groups of four or eight. Look carefully 

at the example and find the groups. Watch the sequence videos and you’ll be able to easily pick out the groups of four 

and eight. 

What’s a group of four or eight?  Think four windows on the second level of the house or eight windows on the first 

level. It could be four sections of bushes or eight segments on a leaping arch. Let your imagination run wild and be 

creative. 

Even though this sequence uses 68 regular channels and 32 RGB based pixels, it works with fewer controllers (channels 

and pixels) attached. Start with just one controller (controller ID 01 and/or ID 07) and add more controllers later. 

The following pages will focus on one controller at a time to make it all easier to understand. 
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Focus on Controller ID 01 

 

If you have only one controller, then this is the one that does the most work. 

Controller ID 01 should be deployed on your main structure. The light channels are used constantly throughout the 

entire song.  

For our example we’ve used four roof segments, four windows, four bushes and four columns. Your venue might be a 

four story building, each with four windows. Think four groups of four. 
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Focus on Controller ID 02 

 

We suggest controller ID 02 be used with accent pieces. The light channels are used to enhance the first 16 channels 

used with controller ID 01. They are not required for a good looking show but you can expand into them in the future. 

Think four groups of four. We use four separate design elements (fixtures), and each is wired with four different colors. 

See the mini-trees in the yard above. You can certainly use your own configuration such as 16 small objects (like candy 

canes or snowflakes) grouped in sections of four. 
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Focus on Controller ID 03 

 

We suggest controller ID 03 be other accent pieces. The light channels are used to enhance the first 16 channels used 

with controller ID 01. They are not required but you can expand into them in the future. Think two groups of eight. We 

use two leaping arches as design elements, where each is wired with eight different light segments. You can certainly 

use your own configuration such as 16 small objects (like snowflakes) grouped in two different sections of eight. 

 

 

 

 

 

 

 

  

 



ReadMeFirst-C68P32.pdf              Light-O-Rama, Inc.     22 Hudson Falls Road, South Glen Falls, NY  12803      www.lightorama.com                   page 15 

Focus on Controller ID 04 

 

We suggest controller ID 04 be other accent pieces. The light channels are used to enhance the first 16 channels used 

with controller ID 01. They are not required but you can expand into them in the future. Think two groups of eight. We 

use two mega-trees of lights as design elements, where each is wired with eight different light segments. You can 

certainly use your own configuration such as 16 small objects grouped in two different sections of eight. 
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Focus on Controller ID 05 

 

Controller ID 05 is not used in the sequence. If you have a ‘You Can Modify’ version of the sequence, feel free to add 

your own props. 
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Focus on Controller ID 06 

 

We suggest the first four channels of controller ID 06 be used for strobe lights. The sequence typically turns on these 

four channels near the end of the music to mark the finale and give drama. These channels are simply turned on and off 

with no dimming. Connect your random firing strobes or strobe strings.  Channels 5-16 are not used. If you have a ‘You 

Can Modify’ version of the sequence, feel free to add your own props. 

Although the sequence has 16 channels allocated for controller ID 06, only the first four channels are used so a four 

channel controller can be used. 

CTB04-PC four channel light controller setting for controller ID 06 (switches 6, 7, 8, 9 are off, ON, ON, off)  

 

(the picture shows switch 8 is on, demonstrating the board is set to controller ID 02) 
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Focus on Controller ID 07 and 20-27 

 

Controller ID 07 is designed for eight RGB pixels and is used constantly during a sequence. We suggest using our 

CMB24D controller with eight dumb pixel ports. Connect dumb RGB ribbons, strings or floods to each port. Since these 

are dumb RGB lights, all the lights on the ribbon or string will be the same color but the sequence can make it any color 

at any time.  

These eight pixels are also duplicated at controller IDs 20-27 and are especially useful with our high-power, single pixel 

floods. 

CMB24D eight RGB pixel controller setting for Unit ID 07 (switches 6, 7, 8, 9 are off, ON, ON, ON)  

 

(the picture shows switch 8 is on, demonstrating the board is set to controller ID 02) 
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Focus on Controller ID 08 and 28-2F 

 

Controller ID 08 is designed for eight RGB pixels and is used as accents during a sequence. We suggest using our 

CMB24D controller with eight dumb pixel ports. Connect dumb RGB ribbons, strings or floods to each port. Since these 

are dumb RGB lights, all the lights on the ribbon or string will be the same color but the sequence can make it any color 

at any time. These 8 pixels are also duplicated at controller IDs 28-2F and are especially useful with our high-power, 

single pixel floods. 

CMB24D eight RGB pixel controller setting for Unit ID 08 (switches 6, 7, 8, 9 are ON, off, off, off)  

 

(the picture shows switch 8 is on, demonstrating the board is set to controller ID 02) 
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Can I use this new sequence with sequences I bought long ago? 

Assuming you purchased your sequences through the official Light-O-Rama sequence store, you can certainly mix and 

match old and new sequences. All Light-O-Rama store sequences are designed to use the first controller (Controller 01) 

constantly and all the other controllers are for accenting or enhancing that first controller. Newer sequences use more 

controllers and those controllers will not be used when older sequences are played.   

Using your purchased sequence with a ShowTime Director 

Light-O-Rama's ShowTime Directors allow you to run sequences without a dedicated computer. You can use the Simple 

Show Builder or the ‘Hardware Utility/LOR MP3’ tab to reformat the sequences so they can be stored on SD memory 

cards and used in ShowTime Directors.  

'Ready To Go' sequences (look for -RTG in the sequence name) can be used with Light-O-Rama ShowTime Directors if 
you are using our S3 software version 3.8 or higher. Previous versions of the software do not allow ‘Ready To Go’ 
sequences to run on ShowTime Directors. 

‘You Can Modify’ sequences (look for -YCM in the sequence name) can be used with Light-O-Rama ShowTime Directors 
using almost any version of our software. 

Please don't share your sequence  

Each sequence has an embedded transaction number we use to link back to your original purchase. Do not share your 

sequence with anyone.  

Commercial use 

Using most musical sequences in a commercial environment means performance licensing. You can do this for each song 

by contacting each artist directly or it's much easier to work with the American Society of Composers, Authors and 

Publishers (ASCAP). Contact ASCAP at www.ASCAP.com or call 1-800-505-4052.  Want more performance licensing 

information?  ASCAP provides thorough explanations at www.ascap.com/licensing/licensingfaq.aspx  

Final suggestion 

Your guests will react to three things: 

1. Lights 

2. Music 

3. The lights flashing in perfect time to the music 

Keep things simple and don’t get bogged down in all the technical stuff. 

Need more help? 

We're always here. Go to www.LightORama.com. You can also use our help desk at helpdesk.LightORama.com 

Our last piece of advice  

Make a backup copy of your sequences and store them somewhere else other than the computer you’re working on. 

http://www.ascap.com/
http://www.ascap.com/licensing/licensingfaq.aspx
http://www.lightorama.com/
http://helpdesk.lightorama.com/

